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1. Introduction 

 

If you need a once-a-day notification to ensure that your equipment is 

operating securely, we have the right asset tracking device for you. Kylos 

Forever will watch over your assets or equipment placed in remote areas for 

months at a time, with its battery that lasts up to 3 years. This way, you can 

keep up with what’s going in your most isolated sites, and reduce the risk of 

having your equipment stolen, lost or possibly forgotten. 

 

While the device is in sleep mode, it will “wake up” and report any situation 

which appears to be out of the ordinary or unexpected. 

 

Kylos Forever is a standalone unit, capable of operating without the need for 

any connection or external wiring – this makes it easily hidden if required, for 

example in a motorcycle. 
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2. Package Contents 

 

 

1. Kylos Forever unit 

2. Kylos Forever USB programming cable 

3. AC charger for units with rechargeable batteries 

 

NOTE: Kylos Forever units can be provided with rechargeable and non-

rechargeable batteries. 
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3. Product Description 

 

 

 

1. On/Off button. 

2. LED indicator 

To turn the unit on, press and hold the On/Off button. The LED will flash 5 

times with a white light and then turn green (if the battery is fully charged), 

or red (if the battery is used). When continuing to press the Operation 

button over 3 seconds, the LED will turn white and start sending a "Button 

On" message. 

After this the LED will blink green until the unit successfully sends a 

message (or 5 minutes have passed). The LED will blink red until the unit 

successfully finds the GPS position (or 5 minutes have passed). 

To turn the unit off, press and hold the Operation button until the light 

turns white and then turns off. 
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Rechargeable and non-rechargeable batteries 

Kylos Forever units can be provided with rechargeable and non-rechargeable 

batteries. 

If you’re not sure whether the unit you received has rechargeable or non-

rechargeable battery, remove the unit cover and look at the battery. 

Rechargeable battery is blue, non-rechargeable battery is white/black/red. 

    
 

Rechargeable battery unit 

 

Non-rechargeable battery unit 
 

WARNING: Attempting to charge a non-rechargeable battery may 

result in in personal injury and battery damage. 
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Technical specifications 

Battery Type 

Power 

Lithium-ion 

3.6 V, 5000 mAh 

Temperature Operational 

Storage 

-20°C to +60°C 

-40°C to +85°C 

Operating 

Humidity 

 Up to 100% 

Size 

Weight 

 165 x 35 x 40 mm 

200 grams 

Cellular 

Communication 

GSM/GPRS (default) 

Optional modems 

Antenna type 

Data channels 

Protocol 

Quad Band (850, 900, 1800, 1900) 

UMTS/HSPA+, CDMA/1xRTT/EV-DO 

Built-in (concealed) 

SMS and TCP/IP 

Propriety – encrypted 

Network Data GSM, GPRS and SMS 

Messages SMS 

GPRS 

Encrypted protocol 

TCP/IP over PPP 

GPS Systems 

Receiver and 

antenna 

Protocol 

Positioning accuracy 

 

Navigation update 

rate 

Navigation method 

 

 

Time to First Fix 

(TTFF) 

GPS, GLONASS (optional) 

Internal 

 

NMEA (Binary format) 

10m CEP (50%) 

Velocity: 0.2 m/s (50%) 

1 second (default) 

 

All-in-view solution, 2-satellite 

solution, A-GPS 

 

Hot start: 2 sec 

Warm start: 10 sec 

Cold start: 50 sec 

CPU Capacity Static RAM 

Nonvolatile memory 

Flash memory 

128 Kb 

34 Kb 

2048 Kb 
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Access Port Type TTL (USB cable is available) 

Power 

Consumption 

Sleep/Idle 

GPS only 

GPRS only 

GPS and GPRS 

0.05 mAh 

75 mAh 

100 mAh 

165 mAh 

Battery Life Transmissions 

Work time 

Every 24 hours 

3 years 

 

 

Industry approvals and certifications 

 

 

For available certificates, see: 

http://wiki.starcomsystems.com/wiki/index.php/Marketing#Certifications. 

 

 

  

http://wiki.starcomsystems.com/wiki/index.php/Marketing#Certifications
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4. Configuration 

 

Downloading the Software 

For the link to download the Installer application setup file, please contact 

Starcom technical support by Email: support@starcomsystems.com, or 

Skype: starcom.support. 

 

Installing the Software 

Locate the folder where you saved the installer setup file. Double-click the 

InstallSetup.exe. The Open File dialog box appears. 

 

 

Click Run. A Windows Security dialog box appears. Click Yes. The Welcome 

to the Starcom Installer Application Setup Wizard window appears. 

  

mailto:support@starcomsystems.com
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Click Next. The Select Destination Location window appears. 
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Click Next. The Select Components window appears. 

 

Click Next. The Select Start Menu Folder window appears. 
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NOTE: Select Don’t create a Start Menu folder checkbox, if you do not 

want to create a start menu folder. 

Click Next. The Ready to Install window appears. 

 

Click Install. The installation starts and a progress bar appears in the 

window, indicating the progress of the installation. 
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When the installation is complete, the Completing the Starcom Installer 

Application Setup Wizard window appears. 

 

Click Finish. 

 

Installing the Update 

To install the Installer update software, locate the folder where you saved 

the update file. Double-click IUpdate.exe. The Open File dialog box appears. 
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Click Run. The Starcom Installer Update window appears. 

 

Verify that the Destination folder points to the location where the Starcom 

Installer software is installed and click Install. A Windows Security dialog 

box appears. Click Yes. The Confirm file replace dialog box appears. 

 

Click Yes to All. The installation starts and a progress bar appears in the 

window, indicating the progress of the installation.  
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The Starcom Installer Update window closes, when the update is complete. 

 

Installing the cable driver 

The Kylos Forever cable driver can be downloaded from the following link: 

http://www.ftdichip.com/Drivers/VCP.htm 

Download the driver for the proper Windows version. 

The driver Installation Guide can be found at the following location: 

http://www.ftdichip.com/Support/Documents/InstallGuides.htm 

Download the Installation Guide for the proper Windows version. Follow the 

instructions in the Guide to install the cable driver. 

 

  

http://www.ftdichip.com/Drivers/VCP.htm
http://www.ftdichip.com/Support/Documents/InstallGuides.htm
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Inserting the SIM card 

Use a Phillips screwdriver to remove the two screws, as shown in the 

following image. 

 

 

Insert a flat screwdriver in the slot between the unit parts. Carefully twist the 

screwdriver to release the inner part from the outer case. 
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Gently push and pull back the SIM card holder to release and open the SIM 

card slot. 

 

 

Place the SIM card in the SIM card slot with its gold contacts facing down, as 

shown in the following image. 
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Lower the SIM card holder back to the horizontal position. Gently press and 

push the SIM card holder forward to snap it back into place. 

 

 

 

Connecting the non-rechargeable battery 

Units with non-rechargeable batteries are shipped with the battery connector 

detached, in order to preserve battery life. Prior to use, the battery must be 

connected. 

 

 

 

Carefully insert the battery connector into the connector socket on the circuit 

board. 
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Push the connector into the socket until it is fully inserted. 
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Connecting the unit to the computer 

Press the On/Off button to turn the unit on. 

Connect the Kylos Forever programming USB cable to the USB output on the 

unit and to the USB port on your computer. 

 

Configuring the unit 

To open the Installer application, from the Start menu select Starcom 

Systems > Installer Application. The Installer company name window 

appears. 

 

Enter your company name and click OK. The Installer window appears. 
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Click Technical > Communications, or press the Communications button 

 on the taskbar at the top of the window. 

 

 

Click the Advanced button . The Communications Window will 

appear. 

 

 

Click the Add button . The Network Selection window appears. 
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Select Helios from the list and press OK to add a Helios network. 

 

The Communications Window will now display the new connection in the 

Available Networks list, which is named Helios 1. (The name "Helios" in this 

case of the unit connection to the Installer applies globally to all unit types). 

 

 

Click on Helios.1 button to configure and activate the connection. 
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Select the COM port number of the Kylos Forever cable port in the Com Port 

menu. In order to verify the COM port being used by Kylos Forever in your 

computer, go to My Computer > Manage > Device Manager > Ports. 
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Set the Baud Rate to 115200. Check the Activate checkbox and click Save. 

 

If the unit has connected successfully, a "Helios.1: on" notification will 

appear in green color at the bottom left corner of the Installer application 

main screen  . 

 

To access the unit parameters, press Technical > Kylos Parameters, or 

right click on the taskbar at the top of the Installer application window and 

press Customize. Select Kylos Parameters and drag/drop it into the 

taskbar. 

 

 

Press on Kylos Parameters and use the settings to configure the unit. 
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Press the Read from unit button  to read the parameters 

already configured in the unit. 
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Network settings 

This tab allows you to enter all the parameters necessary for the unit to 

connect to the network. 

 

 

SMS Destination 

The unit transmits via GPRS by default and via SMS as a backup, when GPRS 

connection is not available. The number to be entered in the SMS 

Destination field is the SIM card number used in the SMS Terminal unit 

connected to the routing server, or the SMPP target number. For more 

information, see SMS Notifications guide. 

 

APN settings 

The APN settings are essential in order for the Kylos Forever unit to transmit 

messages and alerts. The APN settings are provided by your cellular operator 

with the SIM card you are using in the Kylos Forever unit. 
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GPRS APN (Access Point Name) – the name of the gateway provided by 

your cellular operator (e.g. internet). 

GPRS Username – username provided by your cellular operator (e.g. 

blank). 

GPRS Password – password provided by your cellular operator (e.g. blank). 

 

First server – main routing server, which the units transmit to (by default, it 

is Starcom Systems server 1). 

Secondary server – auxiliary routing server, which the units transmit to (by 

default, it is Starcom Systems server 2). 

Port – port open for communication on the routing server (default port is 

6600). 
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Transmission Rates settings 

This tab allows you to configure the intervals of regular tracking 

transmissions, which define how often the unit will transmit its status. 

 

 

Transmission – interval of regular tracking transmissions, which defines 

how often the unit will transmit its status. 

GPS Peek – interval of the GPS update, which defines how often the unit’s 

GPS module will update its location. 

Logging – interval of data logging, during which the unit will wake up only 

for a few seconds to record its current state, but will not transmit. The 

information will be transmitted along with the next transmission (tracking). 

Transmission and GPS Peek values are usually left the same. In some 

instances, these parameters can be configured with different values. For 

example: 

GPS Peek can be faster than Transmission when between the regular 

transmissions the unit can enter or exit a specified perimeter. In such case, a 

Perimeter event created on Starcom Online will be triggered by the change in 

the unit location. For more information, see Chapter 7 – Monitoring. 
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GPS Peek can be slower than Transmission when the unit is installed in a 

remote location for long periods of time, when the GPS update is not really 

required. In such case, Transmission can be set for 1 day, for example, and 

GPS Peek can be set for 5 days (highest value) to save battery power. 

NOTE: It is recommended to configure the unit to transmit once a day, as 

shown in the following image. 

 

With this configuration, the battery should serve for 3 years. 

Transmission rates determine how long the battery will stay charged. Every 

transmission uses the battery. The faster the transmission rate, the faster 

the battery will end. 

When the device is out of GPRS coverage, the messages will be saved to the 

unit memory. Messages saved in the memory can be sent when the unit 

resumes the connection to home cellular network, or to the roaming network, 

if the SIM card used in the unit has a roaming service enabled by your 

cellular provider. 

SMS – select this option if you want the unit to transmit messages saved in 

the memory via SMS. The unit transmits by GPRS by default and by SMS as 

a backup when GPRS connection is not available. For more information, see 

Appendix A – Unit Communication in Starcom Systems. 

Roaming GPRS – select this option if you want the unit to transmit 

messages saved in the memory via roaming GPRS. In order for this to work, 

the SIM card used in the unit must have a roaming service enabled by your 

cellular provider.  
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Hardware settings 

This tab allows you to configure various hardware settings. 

 

 

Use 57600 baud rate – if this option is activated, the device will use 

57,600 bps to communicate. Do not use. 

Light sensor alerts – light sensor enabling option. Not relevant for Kylos 

Forever. 

Use location updates – GPS enabling option. Once activated, the unit’s GPS 

module will be turned on upon every transmission, and location update 

transmissions will be sent. 

Location by Cellular – when enabled, location lookup will be done 

according to cellular antennas if GPS is not available. 

Use debugging beeps – factory testing setting. Do not use. 

Transmit after first start-up or restart – if this option is activated, a 

"Power On" message will be transmitted whenever the unit is powered on for 

the first time, or gets restarted. 

Temperature Low / Temperature High – temperature sensor parameters. 

Not relevant for Kylos Forever.  
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Weak Impact / Strong Impact –accelerometer parameters used to define 

two types of impact (hit, push, drop. etc.) on the device Relevant for units 

with rechargeable battery only. 

Force (g) – determines the threshold of the force needed to be measured in 

order to send an alert. Select "Disabled", if you don't wish to use the alert. 

Duration (msec) – determines the duration of the force needed to be 

measured in order to send an alert. 

Quarter scale – if on, the Weak Impact force will be scaled in quarter of a g. 

This option can be used to make the accelerometer more sensitive to smaller 

impacts. 

The default values configured in the unit are based on the laboratory testing 

results, they were found to be acceptable in most cases. These values can be 

tested and changed according to the specifics of your work. To change these 

values according to specific conditions, you need to test the unit with 

different values and choose the best option. The lower the setting, the more 

often the unit will respond to a weaker impact. 

 

 

Once all the necessary parameters are set, press the Send button 

 to send the changes you made to the unit. 
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Saving the configuration 

If you are planning to configure other units with the same parameters, you 

can save these settings as a *.mem file. Click the Save button  in 

the Kylos Parameters window, select the location where you want the 

configuration file to be saved on your computer, name the file and press 

Save. 

 

Configuring a new unit with the saved configuration 

To configure a new unit with the saved parameters, click the Load button 

 in the Kylos Parameters window, browse to the location where you 

saved the configuration file, select the file and press Open. Click the Select 

All button  to select all the parameters and press the Send 

button  to send the changes to the unit. 
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5. Testing 

 

It is important to test the unit connection to the network, the correct GPS 

location, the unit status and inputs response before installing the unit in the 

container. In order to do this, you need to perform the following steps. 

 

TCP test 

This test verifies that the SIM card is open to the GPRS network, the unit can 

connect to the network and make successful TCP/IP transmissions. 

Press the TCP Test button  (Communications > Advanced 

> Communication Window > Configuration > Helios.1). Wait a few 

minutes until you receive a pop-up window with a successful connection 

message. 

 

If at the end of the TCP Test you do not receive a successful message, check 

your APN settings (Kylos Parameters > Network). Contact your cellular 

provider and make sure the SIM card is open for GPRS. Verify that your SIM 

card is not protected by a PIN code. If necessary, use a mobile phone to 

cancel the PIN code. 

You can also perform the test manually using the Terminal window. Open 

the Terminal window (Communications > Advanced > Communication 

Window > Configuration > Helios.1 > Open Terminal) and type the 

following commands: 

\tdm and press Enter (Modem mode). The modem will be turned on. 

\tr and press Enter. This command runs a series of actions to check the 

parameters such as reception level, visible networks and registered network, 

SIM card state and information. It also attempts to connect to the routing 

server. If successful, a "TCP: Send+" message will appear in the Terminal 

window.  
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GPS test 

NOTE: If you're testing the unit inside the building, it will not be able to get a 

GPS signal in most cases. In order to get a proper GPS location, the unit has 

to be placed outside the building, or outside the window, where it can access 

the satellites. 

Open the Terminal window (Communications > Advanced > 

Communication Window > Configuration > Helios.1 > Open Terminal) 

and type \tdg (GPS mode). GPS readings will be displayed. When you see 

"A,3"... reading, it will indicate a GPS fix signal. 
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If you do not see any response, type \tg1 to turn the GPS on and repeat the 

test. 

 

Unit Status 

Open the Unit Status window. Enter the unit number in the Unit Number 

field, select Request status and press Send. The unit information will 

appear. 

 

Click on the Inputs tab, press the Door and Operation buttons, cover and 

uncover the light sensor, press Request status and check the response in the 

Unit Status window. Use the Location tab to check the unit’s GPS data. Use 

the Various tab to see the unit information. 

 

After all the tests have been performed successfully, the unit is ready to be 

installed. Disconnect the unit from the computer, slide the inner part back 

into the case and fasten the screws. 
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6. Installation 

 

Before installing the unit with non-rechargeable battery, press the On/Off 

button for 3 seconds until you see the LED turn white. Release the button 

and will until both green and red blinks are over. Make sure you get a 

notification for the Button On. 

 

Before installing the unit with rechargeable battery, press the On/Off button 

shortly and make sure the LED color is green. Otherwise recharge the 

battery. 

Charge the battery for at least 12 hours prior to first use. After that, charge 

the battery for at least 6 hours before each use. 

Once the rechargeable battery is fully charged, press the On/Off button for 3 

seconds until you see the LED turn white. Release the button and will until 

both green and red blinks are over. Make sure you get a notification for the 

Button On. 
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7. Monitoring 

 

After the unit is installed, you can monitor its status on Starcom Online. 

Starcom Online is a web based fleet management application with a flexible 

event generator, which allows to set customizable notifications and alerts. 

In your browser, go to http://www.starcomsystems.com/online. Enter your 

username and password in the Username and Password fields, and click 

Sign in. 

 

Starcom Online horizontal menu bar features the following categories: 

• Home – lists the most recently accessed units, including their location. 

• Resources – allows to manage the unit and customer information. 

• Plans – allows to create and manage events and alerts. 

• Monitor – monitors the events and alerts from the unit. 

• Map – displays the actual location of the unit on the map. 

• Reports – generates reports of the unit activity. 

• Profile – allows to configure your user properties. 

• Help – contains tutorials and knowledge base. 

  

http://www.starcomsystems.com/online
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Home 

The Home section shows recently accessed units and latest site updates. 

 

In the Home section, you can find the following additional links: 

Live status – displays the current status of all live units, as shown in the 

following image. 

 

Full list – opens the Resources section that displays a full list of all your 

units. 

Location – opens the Map section that displays a map showing the current 

location of the unit. 

Quick List – links that enable you to access the Resources and Plans 

sections.  
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Resources 

The Resources section shows all your units. 

 

On the left side, the Resources section features the following tabs: 

Units – lists the units. 

Groups – lists the groups of units and helps you create new and modify the 

existing groups. 

Users – lists the users and helps you create new and modify the existing 

users. 

Perimeters – lists perimeters and helps you define new and modify the 

existing perimeters. 

 

Units 

The Units page features the Details area, which arranges the unit 

information in the following columns: 

Number – the unit serial number. Clicking on the unit number link will 

display the Unit Information page, where you can modify the unit 

information. 

Name – displays the icon and the name of the unit. Clicking on it will 

reveal a pop-up menu with the quick access links to the Map and the 

Reports sections. 

Cellular Number – displays the phone number of the SIM card 

installed in the unit. 

Last Message – displays the time and date of the last message 

transmitted by the unit.  
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To create a new unit, click New (not available for evaluation kit 

users). The Unit Information page opens. 
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Active – when selected (set by default), makes the unit active on 

Starcom Online. To make the unit inactive, deselect this checkbox. No 

data will be collected for inactive units; they will appear as dimmed in 

the units list. 

Use this section to enter the unit Number and Name. In the Cellular 

Number field, enter the number of the SIM card installed in the unit. 

In the Unit Type list, select Triton (Kylos Forever uses Triton R 

board). 

No Activity Alert (Hours) – used to receive an alert when the unit 

has stopped transmitting. The default value is 336 hours (2 weeks). 

In the Users window, click on the plus (+) sign on the right and start 

typing the name of the user you want to make the unit available for in 

the Search field. The name of the user will appear in the dropdown list. 

Click on it to add it to the Users list. To remove the user, click on the 

minus sign (-) on the left of the user name. 

In the Groups window, click on the plus (+) sign on the right and 

start typing the name of the group you want to make the unit available 

for in the Search field. The name of the group will appear in the 

dropdown list. Click on it to add it to the Groups list. To remove the 

group, click on the minus sign (-) on the left of the group name. 

 

Use the Cellular Notification section to configure the cellular 

notifications for different events. 

Notify Address 1-4 – enter the cellular numbers you want to receive 

notifications to when the events occur. 

Message – modify the notification message format. The following 

parameters are available: |TIME| |NUMBER| |VEHICLE| |REASON| 

|KEY| |DOOR| |HOOD| |SPEED| |MILEAGE| |XY| |BATTERY|. 

Language – select the language in which you want to receive the 

message. 

Units (kph/mph) – select the measurement you want to receive the 

speed data in. 
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In the Available reasons list, select the reasons you want to receive 

an alert for and click Add. The reasons will be moved to the Notify 

for list. 

When finished, click Apply. The new unit is saved. 

 

To modify a unit, in the Units page, click on the unit name link of the 

unit you want to modify. The Unit Information page appears. Modify 

the unit details as required. Click Apply. The modified unit details are 

saved. 

To delete a unit, in the Units page, click on the unit name link of the 

unit you want to delete. The Unit Information page appears. Click 

Delete. The unit is deleted. 
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Groups 

You can create new and modify the existing groups of units. 

 

To create a new group, click New. The Group page opens. 

 

 

In the Name field enter the name of the new group. 
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In the Units window, click on the plus (+) sign on the right and start 

typing the name of the unit you want to make the unit available for in 

the Search field. The name of the unit will appear in the dropdown list. 

Click on it to add it to the Units list. To remove the unit, click on the 

minus sign (-) on the left of the unit name. 

In the Users window, click on the plus (+) sign on the right and start 

typing the name of the user you want to make the unit available for in 

the Search field. The name of the user will appear in the dropdown list. 

Click on it to add it to the Users list. To remove the user, click on the 

minus sign (-) on the left of the user name. 

In the Sharing section, click the respective checkbox, if you want the 

group to Share Perimeters or Share Events. 

Click Apply. The new group is saved. 

 

To modify a group, in the Groups page, click on the group name link 

of the group you want to modify. The Group page appears. Modify the 

group details as required. Click Apply. The modified group details are 

saved. 

To delete a group, in the Groups page, click on the group name link of 

the group you want to delete. The Group page appears. Click Delete. 

The group is deleted. 
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Users 

You can create new and modify the existing users. 

 

 

To create a new user, click New. The Users page opens. Here you can 

enter the new user information and define their access permissions. 
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Besides entering the user information, you can select the following 

options: 

All units –all the user’s units will be displayed on the Map page. If this 

option is disabled, only the selected unit will be displayed.  
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Show coordinates in reports – the user’s reports will include the 

GPS coordinates. 

Flash Maps – enables the user to see flash maps. 

Report Access – allows to select which reports will be accessible for 

the user. 

Google Maps access – enables Google Maps access on the Maps 

page. 

Allow status requests – enables the user to make unit status 

requests. 

Cellular Commands – enables the user to send commands to the 

unit from a cellular phone. 

Cellular Notification – enables the user to receive cellular 

notifications. 

Mobile Application – enables the user to use Starcom Mobile 

application. Olympia Tracking, Starcom Mobile application, allows to 

receive cellular notifications to your mobile phone. To install, use the 

following link: http://starcomsystems.com/m/ (compatible with 

Android / Apple IOS). 

Lock account after 5 bad login attempts – locks access to Starcom 

Online account after the user has made 5 bad login attempts. 

Force password changing once a month – requires the user to 

change the password once a month. 

Allow editing cellular number – enables the user to edit the phone 

number of the SIM card installed in the unit. 

Allow changing tracking interval – enables the user to change the 

time of the unit tracking interval. 

 

  

http://starcomsystems.com/m/
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Permissions allow you to define the viewing and editing permissions 

of the user for all the sections of the site. 

 

After you configured all the parameters, click Apply. The new user is 

saved. 

To modify a user, in the Users page click on the user name link of the 

user you want to modify. The Users page appears. Modify the user 

details as required. Click Apply. The modified user details are saved. 

To delete a user, in the Users page click on the user name link of the 

user you want to delete. The Users page appears. Click Delete. The 

user is deleted. 
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Perimeters 

You can create new and modify the existing perimeters. 

 

To create a new perimeter, click New. The Perimeters page opens. In 

the Name field, enter a name for the new perimeter. 

 

 

 

To create a new perimeter, click Options > Tools > Create new 

perimeter at the top right corner of the map. Click once anywhere on 

the map to start the perimeter selection (this point would be the top 

left corner of the perimeter). Move the mouse and click again 

anywhere on the map to finish the perimeter (this point would be the 

bottom right corner of the perimeter). 
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In the Perimeter Name field, enter the name of the perimeter. Click 

Ok. The new perimeter is saved and appears on the map. 

 

To view/edit the GPS parameters of the perimeter, click Edit raw 

values. The raw parameters appear. 
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Modify the values as required. Click Apply to save the changes. 

 

After you made all the changes on the Perimeters page, click Apply. 

The perimeter details are saved and the new perimeter appears in the 

list on the Resources section. 

 

To modify a perimeter, in the Perimeters page click on the perimeter 

name link of the perimeter you want to modify. The Perimeters map 

page appears. Modify the perimeter as required. Click Apply. The 

modified perimeter is saved. 

To delete a perimeter, in the Perimeters page click on the perimeter 

name link of the perimeter you want to delete. The Perimeters map 

page appears. Click Delete. The perimeter is deleted. 
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Plans 

The Plans section enables you to create usage plans and to view plans that 

already exist. 

 

On the left side, the Plans section features the following tabs: 

Basic – allows to set up basic plans for LCU500 units. Do not use. 

Advanced – allows to set up advanced plans for LCU500 units. Do not use. 

Events – allows to create events for your units. 

To create a new event, you need to create an event Type first. Click Types. 

The Types page opens. 

 

In this section, you can see the types of events already created in the 

system. You can use one of them, or create a new type. 
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To create a new event type, click New. Enter the name of the event type in 

the Name field. Leave Day of the week and Time Range as "Changeable", 

later you will be able to change these settings in the event itself. 

 

Click the Add Event button and select the event type you want to create 

from the dropdown list. 
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Most of the types listed here relate to the Helios units. The event types that 

can be used for Kylos Forever are: Perimeter, Roaming and GPRS. 

Set the necessary Value. You can leave the Condition as "Changeable", 

later you will be able to change it in the event itself. Select the necessary 

operand in the Operand list, as follows: 

And – when you create several events, this event and the following one will 

be performed simultaneously. 

And then – when you create several events, the following event will start 

only after the first one is performed. 

Transmit – the event will be transmitted. 

End – ends an event. For example, you can create an output event, which 

after it performs the necessary actions will simply end. 

You can create a complex event type, which consists of several events. 

When finished, click Apply. The new event type is saved. 

 

To create a new event, click New in the Events section. 

 

 

Enter the name of the event in the Name field. In the Units list, select the 

units you want to include in the event and click Add. The units will be moved 

to the Available for list. 
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Enter the cellular number and email address to receive the event notification. 

If you select the Monitor checkbox, the event will be displayed on the Monitor 

page (see below) in real time. 

Click the Add Event button and select the type of the event you want to 

create from the dropdown list. 
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Specify the time and date range and the event condition. 

When finished, click Apply. The new event is saved. 

 

For example, let’s create an event, which will send an alert when the unit 

enters a specific location. 

For this, we will use a Location event type already created in the system and 

create a new event based on this type. 

Go to Events and click New. 

 

 

Enter the name of the event in the Name field. In the Units list, select the 

units you want to include in the event and click Add. The units will be moved 

to the Available for list. 

Enter the cellular number and email address to receive the event notification. 

Select the Monitor checkbox, if you want the event will to be displayed on the 

Monitor page in real time. 

Click the Add Event button and select the Location type in the Type list. 
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Enter the name of the event in the Name field. Select the necessary time 

and date range. 

Select the necessary perimeter in the Perimeter list. 

Select Entering in the Condition list. 

Click Apply. The new event, which will send an alert when the unit enters a 

specific location, is created. 
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Monitor 

The Monitor section allows you to select a set of events for a specific unit 

type and to see them displayed in real time. 

 

 

 

On the left side, the Monitor section features the following tabs: 

Monitor – displays the events in real time. 

Settings – allows creating new and modifying existing monitoring events. 

 

To create a new event, go to the Settings tab and click New. The Details 

page opens. In the Name field, enter a name for the new event. 
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Select Triton in the Unit Type list. 

In the Units list, select the units you want to include in the event and click 

Add. The units will be moved to the Available for list. 

In the Available reasons list, select the reasons you wish to receive an alert 

for and click Add. The reasons will be moved to the Notify for list. 

• Main Power Low – alerts you of the battery getting low. 

• Door Opened/Door Closed – not applicable. 

• Weak Impact/Strong Impact – events which show two types of 

impact on the unit (relevant for rechargeable units). 
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• Button Off/Button On – alert that appears when the Operation 

button of the unit is pressed. This can serve as a simple test to 

indicate whether the unit is working. 

• Location Update – event which will update you on the unit 

location status. 

• Power On – alert that is sent when the unit turns on. 

• Light On/Light Off – not applicable 

• Temperature High/Temperature Low – not applicable. 

• No Activity – this event can be used to receive alerts when 

devices have stopped transmitting. The default value is 336 hours (2 

weeks). 

 

Enter the cellular number and email for the notification to be sent to in the 

Notify for section. 

Press Apply. The new monitoring event is saved. 

 

Once the events are generated by the units, they will appear on the Monitor 

page. You will also receive a notification by SMS. The email notifications are 

accumulated and sent once every half an hour to avoid spamming. 
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Map 

The Map page displays the location of a single unit, or a group of units. It 

also shows the unit information and commands. 

 

 

You can select a unit, or a group of units in the dropdown list on the left. 

In the Search field, you can enter the unit number to be displayed. 

Once you select the unit, its location will be displayed on the map and its 

information will appear on the left. 
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The following unit information is displayed: 

 Code – the unit name 

 Location – the address of the last GPS position of the unit 

 Received – the date and time of last transmission from the unit 

 Reason – the reason for the transmission 

 State – the unit logic state (for Helios units) 

 Version – the unit firmware version 
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 Location – the GPS location of the unit, including: 

 Valid – the date and time of the last location transmission from the 

unit 

 Speed – the last recorded speed of the unit 

 Mileage – the last recorded mileage of the unit 

 Location – the GPS coordinates of the last position of the unit 

 Heading – the unit moving direction 

 Altitude – the last altitude of the unit 

 

 IO – unit input information 

 

 Commands 

 Request Status – requests the current status of the unit 

 Tracking – overrides the unit transmission rate settings and forces 

the unit to transmit according to the specified interval. 

 Stop Tracking – stops the tracking command and returns the unit 

to its regular transmission rate 

 Set Mileage – sets the specified mileage value in the unit 
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On the right there are Map Options. Clicking on the Options menu will reveal 

the following options. 

 Search 

As you type the name of a search criterion in the search field, a list of 

matching names, from which you can select the required name, appears. 

 

 Tools 

 Edit perimeter – allows you to edit an existing perimeter. 

 Create new perimeter – allows to create a new perimeter. 

 Distance measurement – allows to measure the distance 

between two points on the map. 
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 Map types 

You can select the following map types: OpenStreetMap, Google RoadMap, 

Google Satellite, Google Hybrid, Bing Road, Bing Aerial, Bing Hybrid, Yandex, 

Native. 

 

 Show 

 Traffic – shows the current traffic conditions (where applicable). 

 Perimeters – displays your perimeters on the map. 

 Labels – displays the unit name next to the unit icon on the map. 

 All units – displays all your units on the map at once. 
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Reports 

The Reports section allows you to generate different unit reports and to 

schedule automatically generated reports. 

 

 

On the left side, the Reports section features the following tabs: 

Instant – allows to generate reports on demand for a single unit or a group 

of units for a specific time period (date and time range). 

Schedule – allows to define scheduled reports that generate automatically 

on a daily, monthly or weekly basis. 

NOTE: The reports can be generated for the last 30 days only. 

 

You can generate the following types of reports: Work Hours, Work Hours 

Summary, Work Hours Group Summary, History, History – Technical, 

Violations, Live Status, Events, Perimeter Entry, Transmit Reasons, 

Monitored events, Stops. 

 

To generate a report, select the report type in the Report dropdown list. 

Select the unit or group of units in the Unit dropdown list. Specify the dates 

and times in the Date Range. Click Generate. 

 

The following is an example of a report generated for one unit on one day 

and for a specific time period. 

  



 
 

69 
 

Kylos Forever User Guide 
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The report includes a map area and tracking details area. The map area 

shows a map of the area in which the unit is located showing points of 

movement of the unit. The tracking details area lists the tracking data of the 

unit. 

The pointers on the map correspond with the numbers in the address column 

of the detailed list of transmissions received from the unit. These numbers 

indicate the points of movement of the unit. The total number of map 

pointers available per report is 50. 

On the bottom of the Map section there is a Play button  that enables you 

to play back the movement of the unit on the map. 

 

To save the report, click Save  . The report is saved as an *.html or 

a *.pdf file. 

To export a report, click Export  . The report is exported as a *.csv 

file, which can be viewed in Excel, to your default downloads folder. 

To print a report, click Print  . The report appears in your default 

browser window where you can select the printer to print out the report. 

 

 

Scheduled reports 

To create a scheduled report, in the Reports section, click Schedule. 

The Schedule page appears. 
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Click New. The Report Scheduling page opens. 

 

 

From the Report dropdown list, select the type of report you want to 

create. 

Tick the CSV only checkbox, if you do not want a map provided with 

the report. 

From the Unit dropdown list, select the unit or group of units for the 

report. 

From the Repeat dropdown list, select if you want the report repeated 

Daily, Weekly or Monthly. 

From the Generate At dropdown list, select the time at which you 

want to generate the report. 

The Send to field is populated with the default email address for the 

unit. You can change this address or add additional email addresses, 

separated by a semicolon.  

Click Apply. The report schedule is saved and added to the list of 

scheduled reports. 
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To modify a scheduled report, in Reports, click Schedule. In the 

Details section, under the Generate column, click the link of the 

report schedule you want to modify. The Report Scheduling page 

appears. Modify the report schedule as required. Click Apply. The 

modified schedule details are saved. 

  

To delete a scheduled report, in Reports, click Schedule. In the 

Details section, under the Generate column, click the link of the 

report schedule you want to delete. The Report Scheduling page 

appears. Click Delete. The scheduled report is deleted. 
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Profile 

The Profile section shows your profile details that were created when you 

purchased your units. You can view and modify these details as required. 

 

 

To view or modify your profile, click the Profile tab, and modify the 

information as required. 

Click Apply. The changes are saved. 
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Using Map Tooltip Format 

The Map Tooltip Format field lets you configure the information that will 

appear in the info window on the Map page when you select a unit. 

To see all the parameters that can be configured in the Map Tooltip Format 

field, click on the green question mark located to the right of the field. The 

Map Tooltip Format legend window will appear. 

 

 

Once you made all the necessary changes, click Apply. Then go to the Map 

page and check the unit info window. 
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Help 

The Help section contains answers to some frequently asked questions and 

Starcom Online tutorials. 

 

 

 

Click on the appropriate tab to access the necessary information. 
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Appendix A – Unit Communication in Starcom 

Systems 

 

Kylos Forever is the mobile component of Starcom’s advanced tracking and 

monitoring system. The system uses advanced software algorithms for field 

tracking of units and provides customers with a selection of real-time 

information about the tracked device. The following image illustrates the 

Starcom Systems communication channels. 

 

The unit transmits messages according to the values specified in Kylos 

Parameters > Transmission Rates settings (GPRS, SMS). 

When the unit’s modem is turned on, it tries to connect to the network and 

transmit via GPRS (4 attempts: 2 on the first server and 2 on the second 

server). If it fails to connect to the network, it will switch to the SMS channel 

(if it is configured to transmit via SMS) after about 4 minutes, because it 

makes four attempts to connect via GPRS. It will constantly try to transmit 

via SMS. 
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The next attempt to transmit via GPRS will be repeated in 5 minutes. Every 5 

minutes, the unit will attempt to connect to the network and transmit via 

GPRS. This process is illustrated in the following figure. 

 

The unit saves all the information that could not be sent in its memory. Once 

it is able to connect to the network again, it will transmit all the stored data. 

The device sends encrypted data to the routing server. When the routing 

receives it, it is decoded and encoded at the same time and sent to all the 

recipients configured in the system. 

 

The message size is 140 bytes (70 bytes data and 70 bytes header). 

 

For more information, see Routing, Control Center and SMS Notifications 

guides. 
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Appendix B – Contacts 

 

For more information about Starcom Systems Company and products, please 

visit: http://www.starcomsystems.com. 

 

Support 

Comprehensive support information is available online at: 

http://wiki.starcomsystems.com/wiki/index.php/Support. 

 

Should you have any questions regarding our system, please contact 

Starcom technical support. For personalized support, use Email: 

support@starcomsystems.com, or Skype: starcom.support. 

 

http://www.starcomsystems.com/
http://wiki.starcomsystems.com/wiki/index.php/Support
mailto:support@starcomsystems.com

